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One thing that’s great about Python is its 
immediacy: you think of something, you type 
the commands and see if it works or not. 

There‘s no compilation, no deployment, no whatever, 
and it’s all great for quick prototyping.

However, for ideas larger than a one-liner, things 
aren’t so good. The Python shell is not very good with 
�O�W�N�V�K�N�K�P�G���J�K�U�V�Q�T�[�����K�H���[�Q�W���U�R�Q�V���C���D�W�I���K�P���C���E�N�C�U�U���F�G�’�P�K�V�K�Q�P����
�[�Q�W���E�C�P�h�V���’�Z���K�V���G�C�U�K�N�[�����6�J�G�T�G���C�T�G���P�Q���Y�T�K�V�K�P�I���C�K�F�U�����N�K�M�G��
code completion. If your idea turns out to be good, 
�[�Q�W���E�C�P�h�V���G�C�U�K�N�[���G�Z�R�Q�T�V���K�V���V�Q���C���U�E�T�K�R�V�����C�P�F���V�J�G�T�G�h�U���P�Q��
�U�V�T�C�K�I�J�V�H�Q�T�Y�C�T�F���Y�C�[���V�Q���U�J�C�T�G���[�Q�W���’�P�F�K�P�I�U���Y�K�V�J���Q�V�J�G�T�U��

By itself, IPython is just a sophisticated Python shell, 
but that’s only a part of the story. Being free software, 
it enjoys a vast library ecosystem. With these third-
party add-ons, you can turn IPython into your testbed 
for programming ideas, an interactive tutorial or even 
a computer algebra system (CAS). 

Getting ready
As an IPython user, you usually work in a console or in 
a web-based notebook. IPython comes with two 
consoles: traditional and a graphical Qt-based one. 
There are several processes involved in a typical 
IPython session. The most important one is the kernel 
(not to be confused with an OS kernel) which actually 
�G�Z�G�E�W�V�G�U���[�Q�W�T���E�Q�F�G�����(�Q�T���V�J�G���P�Q�V�G�D�Q�Q�M�����V�J�G�T�G���Y�K�N�N���D�G��
also a Tornado-based web server. This is known as 
decoupled process architecture: client and 
computational core are separated. You can even run 
them on different machines.

IPython components are glued together with 
ZeroMQ, which is a popular “sockets on steroids” 

library for high-level network communications. We’re 
not going to cover it here, but you should be aware 
that ZeroMQ lacks built-in security mechanisms. So, if 
you’re really going to run IPython in distributed fashion, 
�D�G���U�W�T�G���V�Q���T�G�C�F���V�J�G���T�G�N�G�X�C�P�V���R�C�T�V�U���Q�H���V�J�G���Q�H�’�E�K�C�N��
documentation. In a nutshell, securing IPython kernel 
connections boils down to creating SSH tunnels and 
forcing IPython to listen on loopback addresses.

First steps
�9�K�V�J���G�X�G�T�[�V�J�K�P�I���K�P���R�N�C�E�G�����[�Q�W�T���’�T�U�V���U�V�G�R���K�P�V�Q���V�J�G��
IPython world is straightforward:
val@y550p:~$ ipython

Python 2.7.9 (default, Dec 11 2014, 04:42:00)

Type “copyright”, “credits” or “license” for more information.

IPython 3.0.0 -- An enhanced Interactive Python.

?         -> Introduction and overview of IPython’s features.

%quickref -> Quick reference.

help      -> Python’s own help system.

object?   -> Details about ‘object’, use ‘object??’ for extra details.

In [1]: 

You’ll see a banner revealing some of IPython’s 
powers. % is the so-called “line magic”, because it 
works on a single line, and can be used inside blocks 
of code. There are also “cell magics” that start with 
%% and work multiline. Below is a command prompt 
�Y�J�K�E�J���D�G�J�C�X�G�U���C�U���[�Q�W���O�K�I�J�V���G�Z�R�G�E�V��
In [1]: print ‘Hello world!’

Hello world!

�6�J�K�P�I�U���Y�K�N�N���D�G���F�K�H�H�G�T�G�P�V���J�Q�Y�G�X�G�T�����K�H���[�Q�W�T���G�Z�R�T�G�U�U�K�Q�P��
produces a value:
In [2]: 2+2

Out[2]: 4

INTERACTIVE PYTHON 
COMPUTING FOR EVERYBODY
From trying out code snippets to solving differential equations: 
IPython is a tool that has something to offer for any problem.
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The IPython console sports bright colours and many 
interactivity features.

“Project Jupyter” sounds cooler than “IPython without Python”.

WHY DO THIS?

•  Improve your Python 
shell experience

•  Build a computer 
algebra system 
completely free

•  Create interactive 
tutorials with live code 
samples

Project Jupyter

Some pillars IPython stands on are Python-
�U�R�G�E�K�’�E�����U�W�E�J���C�U��SymPy or Matplotlib. The 
�Q�V�J�G�T�U�����N�K�M�G���F�G�E�Q�W�R�N�G�F���R�T�Q�V�Q�E�Q�N���Q�T���Y�G�D��
�P�Q�V�G�D�Q�Q�M�U�����C�T�G���N�C�P�I�W�C�I�G���C�I�P�Q�U�V�K�E�����U�Q���K�V�h�U��
natural to extend IPython�h�U���D�G�[�Q�P�F���2�[�V�J�Q�P��

This is exactly what project Jupyter does. 
�+�V���V�C�M�G�U���V�J�G��IPython �G�P�X�K�T�Q�P�O�G�P�V�����P�Q�V�G�D�Q�Q�M��
document format and various other bits 

and factors them out. IPython remains the 
�F�G�H�C�W�N�V���2�[�V�J�Q�P���M�G�T�P�G�N�����D�W�V���[�Q�W���E�C�P���U�Y�K�V�E�J���V�Q��
Ruby or anything else if you wish.

If you are using IPython 3.0�����[�Q�W�h�X�G��
probably spotted the Jupyter logo in the web 
�P�Q�V�G�D�Q�Q�M�U���C�N�T�G�C�F�[�����2�N�C�P�U���C�T�G���V�Q���’�P�K�U�J���V�J�G��
split by IPython 4.0�����U�Q���X�G�T�U�K�Q�P�������Z���Y�K�N�N���N�K�M�G�N�[��
be the last “monolithic” one.
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Here, output appears in its own cell. To suppress 
this, end the expression with a semicolon (;). The last 
output is always available via the special variable, _.
In [3]: _
Out[3]: 4

object? prints details about an object. IPython 
gathers these from docstrings, introspection and 
other means, and ?? tries to be even more verbose 
(though it doesn’t necessarily succeed). This feature 
isn’t much help on standard library objects, but is 
quite wordy with IPython’s own ones and various 
IPython-aware third-party libraries.

A double underscore __ refers to the output before 
the last one. To get an arbitrary output, use Out[N] or 
_N, where N is the output’s number (2 below):
In [4]: Out[2]
Out[4]: 4

Note that you can’t refer to printed text this way, as 
print yields no value – it just puts characters on the 
screen. Similarly enough, you can use _i, __i, and In[N] 
(or _iN) to retrieve previous inputs:
In [5]: In[1]
Out[5]: u”print ‘Hello world!’”

A magic called %history prints all inputs in the 
current session. This comes in handy when you’ve 
tried some idea and decide it’s worth putting into 
standalone script. The magic accepts various options 
(like the range of inputs to export) which you can 
examine with %history?. For more sophisticated 
session logging, consider the %logstart and %logstop 
magics. They also produce logs that are valid Python 
code you can readily use.

Writing aids
Session history is also easy to navigate the same way 
you do it in Bash. In fact, both shells relies on the 
readline library for all heavy lifting. Use the Up and 
Down keys (or Ctrl+P/Ctrl+N) to select previous 
inputs, or type some words and press Ctrl+R to search 
history. Unlike the standard Python interactive shell, 
this works multiline.
In [6]: def f(x):
   ...:     return 2 * x
   ...:

Note that IPython automatically indents code when 
you press Enter. The first empty line terminates 

the input. Now, press Ctrl+P: you’ll get back to your 
function and can change it as you like. The only 
inconvenience is that it is really a long wrapped line, 
not a multiline text. You can navigate it with the Left 
and Right keys, Ctrl+A/Ctrl+E (or Home/End), but 
pressing Up or Down still switches to another history 
item. For a real multiline editor, do %edit In[N]. This 
opens input N in a default text editor (likely Vim). Qt 
Console and Notebook can edit multiline cells with no 
external aids.

It is also possible to get one of your previous inputs 
editable at the command prompt. %recall N is the 
magic you need here. It comes in handy when the 
input you need is buried too deep in the history. If you 
only need to rerun the input, use %rerun N.

IPython also provides some writing aids, like Tab 
completion. If you forget a method’s name, type some 
first letters then tap Tab to see the options. Even 
better, you can use shell wildcard syntax and ? to 
search through Python objects:
In [7]: itertools.c*?
itertools.chain
itertools.combinations

101

PdfFileReader complains 
about a malformed file, 
but Tab completion makes 
fixing it easy.

Graphics covered
IPython sports a thing called “GUI integration”. In plain 
words, it means that you can create Qt, GTK and some other 
graphical UI applications straight from the console. It’s a 
useful feature for introspection, especially given the fact 
that IPython can be embedded in your own programs. It 
also comes handy when you need to quickly create a widget 
and test its behavior.

To use it, nothing is required on your side. Just execute 
%gui qt (or other toolkit). Don’t start the main loop 
(QApplication(sys.argv)._exec() or similar) as it will block 
the console. Create your widgets and do other things as if it 
were already running, and IPython will take care of the rest.

IPython’s web terminal is good enough to run the 
ipython console.

Need more terminals
IPython Notebook 3.0 comes with a built-in terminal, 
which is like Chrome Secure Shell but works in any modern 
browser. This requires the python-terminado package, and 
you can create terminals in Dashboard the same way as 
notebooks. It may come in handy for working remotely, but 
keep in mind that this opens shell access to anyone who 
connects to your IPython Notebook server. Be careful not to 
leave your system vulnerable.
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# skipped for brevity
IPython ignores prompts like >>>, In [] or ... in code 

you enter. It’s very useful for pasting doctests and 
code snippets you find online. 

So far we’ve discussed the IPython console, but 
all tricks you’ve learned work in Qt Console (ipython 
qtconsole) as well. History in IPython is per kernel, 
so it is shared between consoles. For instance, run 
ipython console in the terminal, then use %qtconsole 
to start Qt Console connected to the same kernel. 
You should be able to see your previous commands. 
Instead of %qtconsole, you could also use the 
%connect_info magic, which displays the kernel 
connection information and a command line you can 
run to connect to the existing kernel.

To exit the IPython console, press Ctrl+D.

Magic in a shell
IPython provides basic shell command equivalents. 
You can do things like cur_dir = %pwd, %cd another_
dir and %cd - to return back, if you need. Shell 
scripting language is certainly powerful, but not 
necessarily intuitive. If you mix and match it with 
Python, you get best of both worlds.

Think of the following problem. You want to find all 
PDF reports in your Downloads folder that are less 
than five pages long, and copy them somewhere. To 
make it a bit simpler, let our reports have the report_ 
prefix in their names.

Open the IPython console (Qt Console will do as well) 
and let’s begin with:
In [1]: reports = !ls ~/Downloads/report_*.pdf

! denotes a shell command expression. It passes 
the command line to the shell, captures standard 
output and returns it as the result. The actual type of 
‘reports’ is SList, as you can easily check with ?:
In [2]: reports?
Type:       SList
...
File:       /usr/lib/python2.7/dist-packages/IPython/utils/text.py
Docstring:
List derivative with a special access attributes.
...

SList is IPython’s own type that derives from list. 
You can use it as a normal Python list (reports.l), 
a newline-separated string (reports.n), a space-
separated string (reports.s), or a list of Python’s path 
objects (reports.p). For our purposes, we’ll prefer the 

latter form. There is also a convenient SList.grep() 
method, which behaves the same way as the shell 
command.

Next, we’ll loop through reports, getting the number 
of pages in each document. It’s not straightforward 
to do in a shell, but the pyPDF library makes it a 
snap. You can probably find it in your distribution’s 
repositories, and the code we need looks like this:
In [3]: from pyPdf import PdfFileReader
In [4]: from os import path
In [5]: for p in reports.p:
   ...:     with open(p, “rb”) as f:
   ...:         print PdfFileReader(f).getNumPages()

Check that it works (it should). Finally, return to the 
fourth import and change the last line to:
In[6]: # original code here
  ...:     if PdfFileReader(f).getNumPages() < 5:
  ...:         !cp “$p” ~/somewhere/”{path.basename(p)}”

$p is substituted with the string value of the Python 
variable p before the code reaches the shell. You can 
also embed Python expressions into shell commands 
with curly braces. Quotes account for shell-escape 
characters, such as spaces.

The code we wrote isn’t error-proof. If you happen to 
have a .pdf file that PdfFileReader can’t parse (maybe 
an incomplete download), it will raise an error. When 
this happens, note how exceptions are rendered in 
IPython. They’re usually quite detailed, but if you want 
more, try %xmode verbose. Exception tracebacks are 
also coloured so you can grasp them more easily.

Interactive plots work even 
in mobile browsers, but 
you’ll need a live kernel 
connection for them.

Notebooks beyond IPython

The more you get used to IPython, the more likely is you’ll 
want to share a notebook with someone who doesn’t have 
(and doesn’t want) IPython installed. You can always use 
ipython nbconvert, but in the cloud era, there’s a better way.

NBViewer (http://nbviewer.ipython.org) is the closest 
alternative to an online nbconvert. If you have your IPython 
notebook available online (maybe shared in Dropbox) or on 
GitHub/public Gist, simply paste its URL or Gist ID into the 
textbox and you’re done. You can now send your contact 
a link that’s viewable in any browser. The major limitation 
is that you must have your IPython notebook public, and 
there’s also no kernel connection available.

If you’re a professional Python developer, chances are 
you use the PyCharm IDE. It’s commercial, but there’s a 
free (as in beer and as in speech) variant called PyCharm 
Community Edition. Both support IPython notebooks, so you 
can enjoy great interactivity with high-end IDE features like 
code suggestions. However, my experience is that you may 
have trouble getting PyCharm’s IPython support to work. 
PyCharm will also use IPython as a Python shell if available.

PRO TIP
Tab completion in IPython 
also works for files. 
Press Tab and you’ll see 
suggestions, like in a 
regular shell.
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If want a whole block of pure Bash code in your 
IPython session, use the %%bash cell magic. 
Everything you enter in that input will go to Bash 
directly, and the output will be printed. Similar cell 
magics exist for Perl and Ruby.

Pretty plotting
IPython consoles are good for us geeks, but for many 
others around IPython is a synonym for web-based 
Notebook. It’s a great tool for interactive tutorials, 
presentations, and online learning. It also provides 
scientific computing environment rivalling commercial 
tools like Maple or Wolfram Mathematica.

Start the service via ipython notebook, and you’ll 
see the web browser window with Dashboard. 
Dashboard displays IPython documents in the current 
directory and enables you to create new ones. IPython 
Notebook documents (sometimes also called IPython 
notebooks) are just JSON files. You can convert them 
to other formats like HTML or Latex with ipython 
nbconvert. However, in this case you’ll lose much of 
the interactivity.

Notebook itself is a collection of cells. Cells have a 
type: code cells contain Python code, heading cells 
give your document a structure, Markdown cells are 
used for formatted texts and so on. To change a cell’s 
type, use the drop-down under the main menu bar. 
When you’re in command mode (hello Vim!), you can 
move between cells, create, and cut and paste them. 
However, you can’t cut and paste multiple cells, and 
there is no multi-level undo. Clicking on a cell switches 
you to edit mode, where you can change the cell’s 
contents.

To execute a cell, press Shift+Enter or use the main 
menu. It will be evaluated, and the output (if any) will 
appear beneath. All history-related commands you 
know work in notebooks, too. Cell evaluation may 
take time, and a circle at the top-right corner indicates 
whether the kernel is currently busy or not. If it is, 
the circle will be filled. You can interrupt the current 
operation via Kernel > Interrupt or Ctrl+M I. 

Let’s write a simple example that draws the 
trajectory of a small body (like a stone) thrown at 
some angle above the horizon. For that, we’ll need 
plotting facilities. Matplotlib is the de facto standard 
plotting tool in Python. It’s modelled after Matlab (but 
provides a fully pythonic API as well) so drawing 
anything is very easy. First of all, we need to enable 
Matplotlib in the session. To do this, run:
In[1]: %matplotlib inline

“Inline” here means that graphs we plot will appear 
in the notebook and not in a separate window.

Two main factors affect trajectory shape: the initial 
velocity and the angle. The x and y coordinates are 
then easily found as time functions (consult the 
physics textbook of your liking). From a mathematical 
viewpoint, this means the trajectory y(x) is given as 
parametric function. Matplotlib can draw it as well as 
2D/3D plots, histograms and more exotic plot types. 
All we need is to write a simple function:

import numpy as np
import matplotlib.pyplot as plt
def trajectory(velocity, angle):
    g = 9.8
    t = np.linspace(0, 2 * velocity * np.sin(angle) / g, 100)
    x = velocity * np.cos(angle) * t
    y = velocity * np.sin(angle) * t - g * (t ** 2) / 2
    plt.plot(x, y)

We simply find out how long the body will go and 
calculate its x and y coordinates in 100 consecutive 
moments of time during the flight. Now, if you call 
trajectory(5, np.pi/4), you’ll see a curve. But how 
would a change of velocity or angle affect its shape? 
It’s a good question, and IPython has the answer. You 
may be surprised, but making the plot interactive is 
mostly a matter of a one-liner:
from IPython.html import widgets
widgets.interact(trajectory,
    velocity=widgets.FloatSliderWidget(min=0, max=20),
    angle=widgets.FloatSliderWidget(min=0, max=np.pi/2))

interact takes a function and creates widgets to 
manipulate its arguments. It tries to guess appropriate 
widget types (eg uses checkboxes for Booleans), but 
you can always override the defaults as we do here. 
You can also apply it as a decorator:
@widgets.interact
def trajectory(velocity=1, angle=np.pi/4):
    # function body

Play with the plot: for instance, set velocity to some 
fixed value and drag the angle slider to see which 
value gives you the longest flying distance (measured 
along the x axis). You should get something around 
0.78 (np.pi/4). Note however that this will work only 
if you are connected to the kernel, as the function is 
re-evaluated every time you change its arguments. 

IPython encompasses many good technologies, 
and if you want to know more about Matplotlib, SymPy 
or whatever, please drop us a line. In the meantime, 
have a look at https://github.com/ipython/ipython/
wiki/A-gallery-of-interesting-IPython-Notebooks. 
Here, IPython authors collect notebooks from various 
fields that you can use as a starting point for your 
own work, or just for learning. IPython welcomes 
contributions, and if you do something that’s accepted 
upstream, please share it with us!  

Dr Valentine Sinitsyn teaches Physics, develops high-loaded 
services and does other clever things with Python.

Latex makes formulas look 
nice even on the web.

PRO TIP
Always run ipython 
notebook under tmux 
or screen (LV013). This 
way, you won’t interrupt 
a session if you close the 
terminal occasionally.
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WHY DO THIS?
•  Master the building 

blocks of computation
•  Improve your programs 

by manipulating raw bits

If you’ve done even a little programming before, 
you’ll probably have come across the basic logical 
operators AND, OR, NOT and XOR at some point. 

They operate on values that can be either True or 
False. These values are known as Boolean (after the 
mathematician George Boole). For example, take a 
look at the following Python code:
if first_name == “Ben” or first_name == “Mike”:
 print “Cool name!”

This uses the variable first_name and first 
compares it to the string “Ben”. This comparison will 
either return True or False depending on whether or 
not first_name contains “Ben”. Then it will compare 
the variable to “Mike” and again it will return either 
True or False. The OR operation then looks at the two 
values returned, and if either of them is True, the 
whole statement returns True. If neither of them is 
True, then the whole expression returns False 
(actually, there’s a little white lie in this – see the 
boxout for more details).

The operators AND and XOR (exclusive OR) work in 
a similar way. AND returns True if both inputs return 
True, and False otherwise. XOR returns True if either 
one of the inputs returns True, but False if either none 
or both of the inputs return True. The full range of 
outputs from all the logical operations is given in the 
truth tables below.

You can combine these to build up complex 
expressions. Python’s interactive shell is a great place 
to experiment with these. For example:
>>> print False or True
True
>>> print (False and True) or (False or True)

True
>>> print (True ^ True) and (False ^ False)
False

In the last example, the   is used to denote XOR.

Logical operators
As well as these operators that take two inputs, there’s 
the NOT operator, which acts on just a single input 
and changes it, so if it’s True it returns False and if it’s 
False it returns True:
>>> print not True
False
>>>print not False
True

There are three more logical operators that are 
created by combining the two-input operators with 
not. NOR is not and OR, in other words (NOT (a OR B)) 
is the same as (a NOR b).

So far, we’ve been looking at logical operators that 
work with single values, True or False. At a lower level, 
usually, a binary 1 represents True and 0 represents 
False. Since everything in your computer is also 
stored in binary, you can use logical operators on the 
bits that make up larger values.

As an example, the number 4, when represented in 
binary is 100, while the number 3 is 011. If you start 
with the left-most bit of both numbers, you get 1 (or 
True) from 4, and 0 (or False) from 3. True OR False is 
True, so the first bit of our output is 1. Then focus on 
the next bit along. From the 4, this is 0, while from the 
3 you get 1. Again, these OR together to produce 1, 
and likewise with the last bit. The output of 4 OR 3 is 7 
when done bitwise. In Python, this is:

CODE NINJA: BINARY  
BOOLEAN LOGIC
Understand True and False, and program using the very essence 
of computer logic. 

 TUTORIAL
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Truth tables give the 
outputs of logical 
operators for every 
possible set of inputs.
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>>> print 4|3
7

Notice that we used the operator | (the pipe symbol)
rather than OR. That’s because OR works on whole 
values while | operates at  bit-by-bit level. Bitwise AND 
is done with & and bitwise NOT is done with ~. XOR is 
still done with ^.

Binary Booleans
Using bitwise operators on whole numbers works, but 
it looks a bit strange. It’s easier to see what’s going on 
if you view everything in binary, and Python lets you 
do this. Firstly, anything starting with 0b will be treated 
as binary. Secondly, the bin(function) can be used to 
convert a number to binary. So, to display a bitwise OR 
of 4 and 3, but display everything in binary, you can do:
>>> bin(0b100 | 0b011)
0b111
This performs exactly the same function as the 
previous bit of code; the only difference here is that 
we’ve told Python to display everything in binary.

The most common use of bitwise operations is 
applying masks to a value when you are only 
interested in a few of the bits. The two most common 
operators for this are AND and XOR. AND can be used 
when you only want to remove some of the values.

It’s quite common to transmit Boolean values in 
8-bit sequences that are usually interpreted as 
numbers. For example, if you’re controlling hardware, 
you might have eight outputs that you can switch on 
or off. You can send a byte of data to tell the controller 
which ones should be on and which ones should be 
off. Each bit would correspond to a particular pin.  
In order to extract the value for a pin (eg pin 4), you 
could use the following Python code (where the 
variable data_byte contains the data for which pins  
to switch on)
>>> data_byte & 0b00010000

This can be incorporated into an if function. For 
example (where the function set_pin() is used to 
control the hardware):
if data_byte & 0b00010000:
 set_pin(4, “ON”)

The if statement works because Python considers 
anything other than 0 to be 
True.

You can use bitwise OR in a 
similar way because anything 
OR’d with True is always True,  
and anything OR’d with False 
is its original value. This way 
you can manipulate individual bits in the byte. For 
example, to set the fourth bit of data_byte to 1 but 
leave the rest unchanged:
>>> data_byte = data_byte | 0b00010000

Bitwise XOR has a couple of interesting properties. 
Firstly, anything XOR’d with 0 is itself, while anything 
XOR’d with 1 is its opposite. This can be used to 
selectively apply NOT operations to some bits in a 
byte. For example:

>>>bin(0b10101010 ^ 0b11110000)
01011010

Another feature of bitwise XOR is anything XOR’d 
with the same value twice is unchanged. This can be 
used to create a simple (and not particularly secure) 
form of encryption. If you pick a key that’s the same 
length as the message (or repeat a shorter key), you 
can XOR the message and the key once to get an 
encrypted message. You can then bitwise XOR the 
encrypted message with the key again to get the 
original message. So:
message = 0b10101010
key = 0b11001100

encrypted_message = message ^ key
bin(encrypted_message ^ key)

Bitwise operations can cause some strange 
problems because of the way numbers are stored. For 
example:
>>> print ~1

-2
This is because Python stores 

numbers using a method known 
as two’s complement, where the 
largest binary digit is negative 
and subtracted from the rest of 
the numbers. For example, in 

4-bit two’s complement, 1000 is -8, 1001 is -7 (-8 + 1) 
and 0111 is 7. In this case, NOT 0001 is 1110, which 
is -8 and 6, or -2. Python stores numbers in a slightly 
unusual way. Instead of allocating a fixed number of 
bits to a variable (as C does for example), Python 
increases the number of bits depending on how large 
the number stored is. This makes two’s complement a 
little unusual, so carefully test any bitwise functions 
that may operate on negative numbers.  

If you struggle to 
understand binary 
numbers, the Cisco Binary 
Game is a great way to 
learn (http://forums.cisco.
com/CertCom/game/
binary_game_page.htm).

“It’s common to  
transmit Boolean values 

in 8-bit sequences.”
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WHY DO THIS?
•  Learn what compilers do 

behind the scenes
•  Understand the 

language of CPUs
•  Fine-tune your code for 

better performance

ASMSCHOOL: EXPAND  
THE SELF-MADE OS
Part 5: We finish off this series by making system calls accessible 
to user programs, like in a full operating system.

 TUTORIAL

106

MIKE SAUNDERS

Last issue we put together a simple operating 
system, using the techniques and tricks we 
explored over the last four issues. This 

miniature OS consists of a tiny bootloader that loads a 
kernel from a FAT12 formatted floppy disk, and the 
kernel then displays a prompt and takes input. If you 
enter the ls command you get a list of files from the 
disk – or if you enter a filename, the OS will load it and 
try to execute it.

That’s all good and well, but it means our OS is just 
a glorified program launcher at this stage. Proper 
OSes provide facilities to programs, however, so that 
they don’t have to implement everything themselves. 
For instance, every standalone program shouldn’t 
need its own string printing routine – our OS can 
provide that, among other features. So in this final 
instalment of our assembly tutorial series, we’ll beef 
up our kernel with routines that programs can call.

MAKING SYSTEM ROUTINES AVAILABLE1

We’ll be working from the codebase used last month, 
so grab it from www.linuxvoice.com/code/lv015/
asmschool.zip. As a quick reminder, here’s a list of the 
files included and what they do:

  boot.asm The 512-byte bootloader that’s injected 
into the start of the FAT12 floppy disk image.
  bpb.asm The BIOS parameter block, a chunk of 
disk-identification information that is embedded 
into boot.asm during assembly.
  disk.asm FAT12 file-reading routines, as used by 
boot.asm.
  mykernel.asm Our OS kernel, including a simple 
command line and program execution facility.
  lib.asm A set of useful 
routines for screen, 
keyboard and disk 
handling, which gets 
included into mykernel.
asm during assembly.
  test.asm A test 
program that our OS can load and launch – it just 
prints the letter ‘X’ and exits.
To assemble the bootloader, use:

nasm -f bin -o boot.bin boot.asm
To create a virtual floppy disk image called floppy.

img in MS-DOS format, and inject our bootloader into 
the first 512 bytes, do this:
mkdosfs -C floppy.img 1440
dd conv=notrunc if=boot.bin of=floppy.img

To assemble the kernel and test program, and add 
them to the floppy disk image:
nasm -f bin -o mykernel.bin mykernel.asm
nasm -f bin -o test.bin test.asm
mcopy -i floppy.img mykernel.bin ::/
mcopy -i floppy.img test.bin ::/
(Note that mcopy is part of the GNU Mtools package, 

available in most distros.) Now you boot floppy.img in 
a PC emulator such as QEMU or VirtualBox – eg 
qemu-system-i386 -fda floppy.img. So, we have our 
codebase and build instructions. Let’s build MyOS 2.0!

What’s our vector, Victor?
Imagine that test.asm wants to use the lib_print_
string routine inside our kernel. What does it need to 
do? Well, it has to use the call instruction followed by 
the address in memory of lib_print_string. But there’s 
a major problem here: test.asm has no idea where 
lib_print_string is. If we disassemble our kernel using 
ndisasm mykernel.bin, and search for “pushaw” (the 

first instruction in the 
lib_print_string routine), 
we can see that the code 
for lib_print_string starts 
at position 557 
(hexadecimal, in the 
column on the left).

So, that’s a start – test.asm could just put a string 
location in SI and use call 0x557 to print a string, 
right? That may indeed work, but here we bump into 
another problem: the location of lib_print_string will 
change as we make modifications to the kernel. It 
could move by just a few bytes if we make a minor 
alteration, or it could jump by several kilobytes if we 
add loads of code to lib.asm before it.

Fortunately, however, there’s a way to fix this: using 
vectors. If we put a series of jmp instructions at the 
beginning of our kernel, which jump to different 
routines in lib.asm, these will always stay in the same 
place. These jumps are called vectors and redirect call 
instructions from programs to the appropriate places.

Let’s see this in action. Edit mykernel.asm and add 
three jmp instructions and a “start” label to the very 

“Every program shouldn’t need 
its own string printing routine 
– our OS can provide that.”

LV016 106 Coding ASM.indd   106 07/05/2015   18:05



MACHINE CODE CODING

www.linuxvoice.com 107

top so that it looks like this:
 jmp start  ; 0x0000
 jmp lib_print_string ; 0x0002
 jmp lib_input_string ; 0x0005

start:
 mov ax, 2000h
 mov ds, ax
 mov es, ax

loop:
 mov si, prompt
 call lib_print_string
 ...

The hexadecimal numbers in the comments 
alongside these jmp instructions show exactly where 
they’ll be in RAM when the kernel is loaded. So, the 
jmp start instruction is at position 0 (as it’s right at the 
start of the kernel), while jmp lib_input_string is at 
position 0x0002, and the next jmp is at 0x0005. (The 
first jmp instruction is only two bytes, as it’s jumping 
to a very close address, just a few bytes ahead, 
whereas the other jmps use three bytes and go to 
code further away, and therefore use longer 
addresses.) You can find out the location of these 
jump instructions using ndisasm mykernel.bin – the 
locations are in the left-hand column.

Make it easier for other developers
So, we’ve created three vectors here: if a program 
wants to use lib_print_string, instead of using that 
routine’s exact address in memory, it can simply call 
the vector at position 0x0002, which then redirects to 
lib_print_string. This vector will always remain at 
0x0002, unless we change the order of the vectors – 
but as Linus Torvalds always says with colourful 
language, you NEVER break userspace – so our 
vectors won’t change location. We can add more of 
them, but that doesn’t change the location of the 
previous ones.

Try this out by modifying test.asm like so:
 ORG 32768

 mov si, string
 call 0x0002
 ret

 string db “Ciao!”, 0
Assemble the kernel and test.asm and then copy 

them to the disk image as per the previous 
instructions, and boot up the OS. Run test.bin and 
voilà: it uses the kernel’s lib_print_string routine. It 
doesn’t care where that routine is in RAM, but knows 
that it can call the vector at 0x0002, which will then 
jump to the right place.

And the same is true of lib_input_string – we’ve 
also added a vector for that. You can now go ahead 
and add other vectors for routines in lib.asm, making 
them available to standalone programs. Yes, our 
project really is becoming a proper operating system!

More real-hardware fun, this time showing the use of graphics routines we’ve added to 
our simple operating system.

But now imagine that you want to get other people 
to write software for your OS. If you tell them to call 
various hexadecimal numbers, it all looks a bit hacky, 
so we can make our pseudo-API more attractive by 
aliasing proper names to the numbers. Alongside  
test.asm, create a file called myos.inc with the 
following contents:
lib_print_string equ 0x0002
lib_input_string equ 0x0005

The equ here simply means: the string on the left is 
equivalent to the number on the right. So now you can 
modify test.asm as follows:
 %include “myos.inc”

 ORG 32768

 mov si, string
 call lib_print_string
 ret

 string db “Ciao! inc”, 0
By including myos.inc into our test.asm file, we can 

use human-readable names for the routines and not 
just the hexadecimal numbers (although those will 
still work, of course). As you add more routines to  
lib.asm and make them accessible via vectors at the 
start of your kernel code, you can add more equ 
statements to myos.inc and make it easier for people 
to write programs for your OS.
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What’s next?
So, where do you go from here? The next step is to explore 
some other x86 real-mode 16-bit operating systems, such as 
MikeOS (http://mikeos.sf.net). No, that isn’t just a cheap plug 
– MikeOS is very similar to the mini OS we’ve made here, albeit 
with many more library routines and kernel features. But the 
memory layout and use of vectors is the same, the code is well 
commented, and there’s plenty you can nab for your own OS 
(it’s under a BSD-like licence).

After that, you’ll want to explore something more powerful. 
KolibriOS (www.kolibrios.org) is a mightily impressive 
graphical desktop operating system written in assembly 
language, which features pre-emptive multi-tasking, various 
filesystem drivers, and other cool features. KolibriOS is a fork 
of MenuetOS (www.menuetos.net), which is open source in its 
32-bit incarnation, and includes extra sound and network 
drivers. It’s insanely fast, but still rather limited compared to 
the likes of Linux and the *BSDs.

Of course, x86 isn’t the be-all and end-all of assembly 
language. In fact, many coders regard it as a very ugly 
language, due to all the cruft that has been added onto it since 
the 1980s (the upside of this is excellent backward 
compatibility). ARM chips are everywhere these days, and 
while most of them are in embedded or locked-down devices 
such as phones and tablets, if you have a Raspberry Pi you 
can start hacking ARM assembly code straight away.

There’s a good starting tutorial at http://tinyurl.com/
nsgzq89, which explains how to assemble and link binaries, 
and then moves on to the specifics of the ARM chip in the 
subsequent chapters. Note that while ARM has different 

instructions and registers from x86, most of the concepts you 
learn are the same in any assembly language. (Well, unless 
you start coding for extremely limited embedded chips that 
don’t even have multiply instructions!)

Once you’re up to speed on ARM, you could try making your 
own OS for the Raspberry Pi. This is considerably more 
involved than our tutorial series, as you have no BIOS to help 
you out – indeed, you have to write your own video driver early 
on just to display anything on the screen! But it’s good fun, so 
check out this guide: www.cl.cam.ac.uk/projects/raspberrypi/
tutorials/os.

The Raspberry Pi rocks for many reasons, but it’s also 
the ideal platform for learning ARM assembly.

We’ve worked hard over the last five issues, so it’s 
time to play hard as well by adding some graphics 
capabilities to our OS. As with the keyboard, screen 
and disk routines, the BIOS can help out here – 
although it’s not especially fast. If you had wanted to 
write lightning-fast games back in the glory days of 
MS-DOS, you’d have worked with video RAM directly, 
but in our case we can ask the BIOS to plot pixels for 
us and do the grunt work.

First up, we need to create three routines: one to 
enable graphics mode, one to plot a pixel with the 
specified colour and location on the screen, and one 
to return to text mode. Open lib.asm and add the 
following routines:
lib_gfx_mode:
 pusha
 mov ah, 0
 mov al, 13h
 int 10h
 popa
 ret

lib_text_mode:
 pusha
 mov ah, 0
 mov al, 3
 int 10h
 popa
 ret

lib_plot_pixel:
 pusha
 mov ah, 0Ch
 mov bh, 0
 int 10h
 popa
 ret

The first of these, lib_gfx_mode, uses the BIOS (int 
10h, routine 0) to switch to 320x200 pixel mode with 
256 colours at your disposal. Sure, it’s very low-res by 
modern standards, but plenty of great games were 
written in this limited environment! The second routine 
switches back to text mode, and the third plots a pixel 
and takes three parameters: the colour in the AL 
register, the X (horizontal) location in the CX register, 
and the Y (vertical) location in DX.

Next up, add vectors to these at the start of your 
kernel. If you haven’t added any other vectors for 
routines in lib.asm yet and you only have the three we 
created earlier, you can add them onto the end like so:
 jmp lib_gfx_mode        ; 0x0008
 jmp lib_text_mode       ; 0x000B
 jmp lib_plot_pixel      ; 0x000E

(Again, the vectors are three bytes apart; use 
ndisasm to see where all the jmps are in mykernel.bin 
if you’re not sure.) Now open myos.inc and add the 
appropriate equ lines for these routines, so that other 
programs can use them, and then edit test.asm. Here 

FUN WITH GRAPHICS2

LV016 106 Coding ASM.indd   108 07/05/2015   18:05



MACHINE CODE CODING

www.linuxvoice.com 109

Mike Saunders is now moving on to coding mostly in 1s and 
0s, with the odd 2 thrown in for good measure.

Steve Ballmer was right – it’s all about developers, developers, developers, developers! 
Win them over with an API for your operating system.

It’s a good idea to document your system calls so that 
you (and others) know exactly which registers they take 
and return.

we’re going to write a program that draws horizontal 
lines of pictures on the screen, from top to bottom, 
changing colour each time. This program makes use 
of an inner and outer loop, so it’s a good way to beef 
up your assembly knowledge with concepts you’ve 
probably come across in higher-level languages. 
Here’s the code:
 %include “myos.inc”

 ORG 32768

 call lib_gfx_mode

 mov al, 0
 mov cx, 0
 mov dx, 0

outerloop:
 inc al
 inc dx
 cmp dx, 199
 je $

 innerloop:
  call lib_plot_pixel
  inc cx
  cmp cx, 319
  jne innerloop

 mov cx, 0
 jmp outerloop

Here, after switching to graphics mode, we set our 
colour, X position and Y position registers to zero. 
Then we begin our outer loop, which bumps up the 
colour by one and moves on to the next line. If we’ve 
reached line 199 (the bottom of the screen), then we 
execute jmp $, which jumps to the same instruction in 
the code – thereby setting up an infinite loop. (Yes, the 
only way out of this program is to reset the machine!)

If we’re not at the bottom-most line, however, we 
begin an inner loop. This plots a pixel at the current 
location and then adds 1 to the CX, moving to the right 
each time. When we hit the right-hand side (319) the 
loop ends, so we reset the X position back to zero and 

return to the outer loop for the next line. Build the OS 
and boot it, and you’ll see results like in the picture – 
not bad for such a small program, is it?

Custom lines and shapes
With this knowledge, you can now build some custom 
routines to draw straight horizontal and vertical lines, 
and even filled or outlined boxes. But what about 
arbitrary lines from one point to another? This is a bit 
more complicated, but one solution is to use 
Bresenham’s line algorithm. This determines the pixels 
that need to be plotted on the screen when a straight 
line is drawn from one point to another. The maths 
involved in this is beyond the scope of this tutorial, but 
there’s some pseudocode at http://tinyurl.com/
k6qsxty, which will help you to implement it.

The web is full of x86 assembly language 
implementations of the algorithm, such as http://
bloerp.de/code/asm/x86/line.html, so do a bit of 
Googling and see how it’s done. You can find similar 
code chunks explaining how to draw circles and other 
shapes. If you’re feeling especially ambitious, and 
have plenty of time, you could even try adding mouse 
support. The BIOS doesn’t provide any routines for 
this, but you can write a simple PS/2 mouse driver 
and many PCs will emulate USB mice as PS/2 ones 
(in 16-bit real mode). See http://wiki.osdev.org/
Mouse_Input to get started – and note the links at the 
end of the page, which include example code listings.

And that’s it! We’ve come to the end of our journey 
through the awesome land of assembly language, 
and hopefully it has whetted your appetite to explore 
even further. Keep banging those bits and bytes on 
bare metal, and if you ever happen to land a six-figure 
salary from an assembly language-related job, this 
author wouldn’t object to a free beer in the post… 
happy hacking!  
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PRO TIP
You can tell if a track is 
active by the colour of the 
track menu — an active 
track’s menu is a darker 
shade than an inactive 
track’s menu.

Enhance with effects

One of the coolest features of Audacity are 
the dozens of effects housed under the 
Effect menu. Besides the Noise Removal 
effect that we’ve demonstrated in these 
pages, there are several other useful ones 
that you can use to enhance your recordings. 
The Change Pitch effect lets you alter the 

pitch of your voice without changing the 
tempo. Use the Echo effect to dramatise 
announcements, or the Reverse effect to play 
a track back-to-front for fun. There’s also the 
Compressor effect, which equalises volume 
variations in the track by effectively making 
the quiet parts louder.

A udacity is one of those rare breed of open 
source software that Linux users love to 
flaunt. It runs across platforms and packs in 

more tricks than Gandalf. You can use the incredibly 
powerful and versatile application for everything from 
recording music, vocals, instruments and other 
sounds and editing them into a professional sounding-
mix. One of the most popular uses of Audacity is to 
churn out podcasts, though you can also use it to 
compose tracks for your garage band, record 
voiceovers, capture audio from apps, make ringtones 
and do a lot more. 

All this robustness hides behind an interface that 
might appear cryptic to new users, but it’s also fairly 
intuitive and grows on you when you start using it. 
Grab Audacity from your distro’s official repository, 
either with
sudo apt-get install audacity
if you use a Debian-based distro or
sudo yum install audacity
on Fedora-based distros. While Audacity is equipped 
to export Ogg files, if you wish to save your recordings 
in other formats such as MP4 you’ll need to make 
sure your distro includes the FFmpeg libraries. 
Similarly, for saving as MP3 you’ll need the Lame 
encoder. You can install them both from your distro’s 
package manager. 

The first thing you should do when you launch 
Audacity is to check your recording hardware. Bring up 

CAPTURE AND TWEAK AUDIO 
WITH AUDACITY
Your one-stop tool for melodiously enhancing recordings and audio files.

the pop-up menu next to the microphone icon in the 
top bar and select the Start Monitoring option. Now 
speak into the microphone and if the input meters 
respond, your recording hardware is properly hooked 
up. Note however that the meters shouldn’t hit 0dB. If 
they do, lower the record volume using the Input 
Volume slider on the right, or using your distro’s Sound 
Settings dialog.

Before you capture any audio, make sure the audio 
sampling rate is set higher than 22050Hz. By default 
the app sets this to 44100Hz (in the bottom-left 
corner of the interface) and you should leave it as is. 
Now click the red button and start talking. Use the 
Pause button to take a break and resume recording 
from where you left off. When you’ve finished, click the 
Stop button. If you press the Record button again, 
Audacity will record the audio in a new track. Instead, 
to continue recording from the end of the original 
track press and hold the Shift key before clicking the 
Record button again.

Polish your recordings
If your cat pounced on you in the middle of a sentence 
and you let out a PG-13 utterance or an R-rated 
expletive, you can continue recording and easily take 
them out later. When you’re done recording, select the 

BEN EVERARD

MAYANK SHARMA

While exporting a recording you can also attach various 
optional metadata with the file. 

Manipulate sound, filter the noise and rub some funk on your 
masterpiece. 

MASTERCLASS
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PRO TIP
Go to Tracks > Add Label 
At Selection to mark 
positions in a track. This 
is useful for annotating 
bits in a long piece of 
audio such as an 
interview.

PRO TIP
Go to Tracks > Mix and 
Render before exporting 
your recording. This will 
merge all your tracks into 
one single track that you 
can then clip, normalise, 
and enhance as a whole. 

zoom tool from the Tools toolbar and highlight the 
portion of the track that contains the aberration. Then 
activate the selection tool, carefully select just the bit 
that you want to zap, and hit the Delete key. You can 
also remove unnecessary portions from the recording 
using Audacity’s trim tools. Suppose a track has a lot 
of silence at the beginning and the end. In such a 
case, select the region of the audio that you’d like to 
keep and click the Trim Outside Selection button from 
the Edit toolbar to trim all audio not in the selection.

Another common editing task is to remove 
background noise. Using Audacity’s Noise Removal 
tool, which has been significantly improved in the 
latest version, you can take out constant background 
sounds such as fan noise, carrier noise and such. 
Head over to Effect > Noise Removal, click on the Get 
Noise Profile button and select a region of the 
recording that only contains the noise. Then head 
back to Effect > Noise Removal and experiment with 
the noise removal parameters. Use the Preview button 
to listen to a few seconds of audio and tweak the 
parameters accordingly until you’re satisfied. 

Sometimes you might want to reposition sections 
within your recording. For example, if you’ve recorded 
a podcast with multiple sections in a particular order 
and then later decide to rearrange the order of these 
sections. Instead of re-recording the podcast, you can 
cut-copy-paste sections of the track just like you 
would in a text editor. Select the portion you wish to 
move and press Ctrl+X to cut it. Then move to the 
position where you want to insert it and press Ctrl + V 
to paste it. 

Mixing tracks
If you wish to record from two microphones, you’ll 
need a soundcard that can record from multiple 
channels or you can connect the microphones to a 
mixer which you can then hook up to your computer. If 
you’re on a budget, you can record different sources in 
multiple tracks and then combine them with Audacity. 
So if you have a band, you can record vocals in one 
track, the guitar on another and the drums on the third. 
Once you have the three tracks, start a new project 

and head to File > Import > Audio and select the first 
audio track. Repeat the process to import all three 
tracks and then hit Play to enjoy your masterpiece. 

Another use of the mixing tracks features is when 
you wish to mix narration with some background 
music or overlay section announcements on top of a 
longer podcast. On the left of each track is the Track 
Control Panel. It presents relevant information about 
each track, including its sample rate and bit depth. 
Use the pull-down menu next to the Track title to 
rename the track. 

Then there’s the Mute button, which cuts the audio 
of the track from the mix when you hit the Play button. 
Conversely, the Solo button cuts out the rest and only 
plays the audio from the corresponding track. At the 
bottom is the track’s Pan Control, which lets you 
adjust the track’s audio either to the left or right. Above 
this is the track’s Gain Control, with which you can 
control the relative volume of the track.

In order to blend tracks, begin by first splitting the 
main track into multiple clips. Use Edit > Clip 
Boundaries > Split and insert a split where you need to 
insert audio from another track. You can split a track 
into as many clips as you want. Similarly split the 
other track, then use the Time Shift tool from the 
Tools toolbar, at the top of the Audacity interface, 
make room for the bits from the other track. 

If you have places in the track where the music 
overpowers the voice, you can fade down the music 
when the voiceover begins and turn it back up at the 
end. For this, select the Envelope tool, next to the 
selection tool. When you activate the tool you’ll notice 
horizontal lines at the top and bottom of each track. 
These are representations of the track’s volume, 
which by default are at 100%. Then in the music track, 
head over to the area where you need to fade the 
music and click, hold and drag at either the top or the 
bottom line to reduce the volume of the music. You 
can also click inside the music track envelope to add  
control points and drag the envelope to create a 
desired shape. Experiment with the shape of the 
envelope until you’re satisfied.

All this might sound a bit confusing at first, but this 
flexibility enables you to create complex compositions 
by mixing multiple smaller tracks.

If you plan to work with 
Audacity on a regular basis, 
make sure you familiarise 
yourself with its keyboard 
shortcuts.

Don’t be overwhelmed by the tweakable parameters of the 
various options and effects. Most of them can be applied 
only after trial-and-error. 
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Sox is the Swiss Army knife of command-line 
sound editing tools. While it lacks the more 
powerful features and the graphical interface of 

Audacity, Sox is incredibly versatile and has the 
batch-processing advantage of a command line utility. 
The tool is adept at several common sound editing 
tasks such as converting files into different formats 
and applying sound effects. 

Grab Sox from your distro’s mirrors either with sudo 
apt-get install sox or sudo yum install sox depending 
on your distro. Also grab the libsox-fmt-all package, 
which includes all of the Sox libraries and the ability to 
work with various file formats including MP3.

Once you have the tool and the libraries, converting 
files from one format to another is a simple affair. The 
command sox some-file.mp3 great-file.ogg will 
encode the MP3 file into Ogg. As you can see, Sox 
recognises the formats of the input file and the output 
file from the extension of the file.

Before you can manipulate a file, you’ll need to 
know its encoding information. The command 
sox --i some-file.ogg
will list various details about the file including its 
sample rate, file size, bit rate, and more. 

If you wish to reduce the size of the audio files on 
your disk, one way to do so is to reduce their sampling 
rate. The command
sox some-file.ogg -r 16k downsampled-file.ogg
will change the sampling rate of the file down to 
16kHz. Now check the file again with the --i switch 
and note the changed sampling rate and the reduction 
in file size.

One of the most popular ways of using Sox is to do 

HACK AUDIO FILES WITH SOX
on-the-fly processing. For example, we use the PiFM 
script, which enables us to use the Raspberry Pi as a 
low-power FM transmitter. It’s very easy to implement 
and enables us to listen to audio even on older FM 
players that don’t have Wi-Fi. However, the script can 
only play audio files that are 16-bit 22050Hz mono 
and in the WAV format. Instead of first converting all 
our music into WAVs to conform to these restrictions, 
we use Sox to process the file on the fly and then pass 
it on to the script. The command:
sox -t ogg SomeSong.ogg -t wav -r 22050 -c 1 - | sudo ./pifm 
- 100.1
will translate the Ogg file into a WAV file, change its 
sampling rate to 22050Hz and down mix the track to 
a mono channel. The converted audio is sent to the 
standard output, denoted by the hyphen sign (-) and is 
then piped (|) into the standard input of the pifm 
command. The script will then broadcast it on the 
100.1 FM frequency. 

You don’t even need the file on your disk. If you wish 
to broadcast the Linux Voice podcast, you can do so 
with the command:
sox -t ogg http://www.linuxvoice.com/episodes/lv_s03e05.ogg -t 
wav -r 22050 -c 1

The only difference between this command and the 
previous example is that instead of pointing to a local 
Ogg file, we are now pointing to one that resides 
online. Similarly, you can use Sox to convert an online 
radio station and pipe it to the PiFM script, like so:
sox -t ogg http://network.absoluteradio.co.uk/core/audio/ogg/
live.pls?service=a6bb -t wav -r 22050 -c 1

Not all stations broadcast Ogg streams. To convert 
MP3 streams all you need to do is change the type of 
the input file you are converting with Sox, like so:
sox -t mp3 http://www.ndr.de/resources/metadaten/audio/m3u/
ndrloop5.m3u -t wav -r 22050 -c 1 

Audiophiliac remedies
Besides converting music, there are various other 
ways you can manipulate audio with Sox. You can, for 
example, use it to extract a part of audio with the trim 
switch. The trim switch accepts two parameters: the 
starting point of the portion you wish to keep and the 
second denotes its length. For example,
sox original.ogg beginning.ogg trim 0 10
will extract the first 10 seconds from the original.ogg 
file. Conversely, if you wish to clip the first 10 seconds 
and keep the rest, first find the duration of the track in 
seconds with the
sox file.ogg -n stat
command. Make a note of the value listed next to the 
Length (seconds) parameter. Let’s assume ours reads 
2965.12. Then use the command 
sox original.ogg silence-clipped.ogg trim 20 2945.12

Surgically manipulate audio with this command-line gem.

MAYANK SHARMA

PRO TIP
Use the avg parameter 
when converting a 
multi-channel Stereo 
track to Mono.

Use the -S switch to keep 
an eye on the progress of 
ongoing activity.
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Here 20 is the starting point of the recording we wish 
to preserve, and 2945.12 is the original length minus 
the first 20 seconds. 

An easier way to do this is to specify the length of 
the track you wish to clip. So if you wish to lop off the 
first 10 seconds, use
sox original.ogg start-clipped.ogg trim 10

Similarly you can also clip from the end of the track. 
The command
sox original.ogg end-clipped.ogg reverse trim 5 reverse
will reverse the track, trim 5 seconds from the 
reversed track and reverse it back again, which 
effectively removes the last 5 seconds of audio. 

You can also use Sox to merge multiple audio files 
into one. The command
sox -m background-music.ogg commentary.ogg great-show.ogg
will combine the background-
music.ogg file with 
commentary.ogg so that they 
overlap each other in the 
great-show.ogg file. 

Sox also lets you add a 
fade-in and fade-out effect to 
a track. The command 
sox music.ogg with-fade-in.ogg fade 10
will slowly raise the volume from zero to maximum in 
10 seconds. If you wish to add a fade-out effect as 
well, you’ll need to know the length of the track. 
Assuming the length of the track to be 400 seconds, 
the command
sox music.ogg with-fades.ogg fade 10 400 5
will add a 5 second fade-out at the end of the track in 
addition to the 10 second fade-in. 

There are several other ways you can alter the 
audio, some more useful than others. For example, 
you can also speed up or slow down a file by 
changing its pitch by a particular factor. The default 
pitch factor of a file is 1.0. The command 
sox normal.ogg faster.ogg speed 2.0
will double its speed and also reduce the duration of 

the clip by half. 
Sox also includes two other command-line utilities. 

There’s the play utility, which is basically just a shell 
script that calls Sox to play an audio file over the 
default audio device. So
play some-audio.ogg
will play the file. Since it’s just a script around Sox you 
can use play to hear a file without actually modifying 
it. So if you wish to boost the bass of a song but aren’t 
sure of the value you want to boost it by, you can use 
the play command. The command
play some-audio.ogg bass +3
will play the file after boosting the bass 3 notches 
without touching the original file. 

Sox also comes with a recording utility. The 
command

rec voice.ogg
will start recording from the 
default recording device. It’ll 
record until you use the Ctrl + 
C hot key to abort the 
operation. The recorded  
clip will be saved in the voice.

ogg file. You can also limit the duration of the 
recording. The command
rec record-voice.ogg trim 0 10
will record for only 10 seconds. And you can even use 
other switches as well. The command
rec -r 16k -c 1 voice.ogg trim 0 10
will record for 10 seconds and then downsample  
the recording to a single channel audio with a 16k 
sample rate. 

There’s so much more that you can do with Sox. 
We’d run out of paper if we attempt to cover 
everything you can do with the utility. But rest assured 
that if you need to modify an audio file, chances are 
you can do it with Sox  .

Mayank Sharma has been finding productive new ways to 
mess about with free software for years now.

PRO TIP
You lose some 
information when 
converting to some 
formats, such as like 
MP3, that compress 
audio. Know that 
converting back again 
from such formats will 
not produce an exact 
copy of the original.

PRO TIP
Add a small amount of 
stereo reverberation 
effect to a mono file with 
the -w switch to make it 
sound more natural.

“If you need to modify an 
audio file chances are you 
can do it with Sox.”

You can use Sox to start 
recording when it detects 
audio and stop when it 
detects a specified length 
of silence.
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Last year I backed a Kickstarter for a 3D 
printer. In fact I backed several, but there 
was one I was particularly keen on seeing. 

Everything would be straightforward and ‘Just 
Work’, etc. So far it’s six months late, but hey, I 
was expecting that.

What I wasn’t expecting was the slide on their 
promises. When I backed the Kickstarter, it 
proclaimed it would work with Windows/Mac/
Linux. I didn’t pay that much attention to it at the 
time, because after all, what idiots would 
produce a 3D printer without making it 
compatible with all the industry-leading 3D 
software out there. Let’s face it, home 3D printing 
was invented (whatever those Makerbot sell-out 
turncoats would have you believe) by the 
RepRap project, using open hardware and open 
source software. In Bath, as it happens.

Fast forward a few seasons, and a website is 
duly created. Worryingly it now says “Windows/
Mac. Linux support is also likely”. When the 
printers start shipping, I discover that they have 
spent at least 12 months hiring developers and 
writing their own software! Not their own 
front-end or anything, but a complete Windows 
application, helpfully written in something that 
will be hard to port to Linux.

The developers have kindly enabled an option 
not to ship the printer before the software is 
ready for those platforms, but as they can’t say 
when that will be, and haven’t even started 
working on it, I don’t want to wait another year…

The worst part of all is that all this info has had 
to be dragged out of them. The ‘we are too busy 
to respond’ excuse is pointless and foolish when 
you have a website and a forum – it actually 
saves time! If you are starting a Kickstarter, don’t 
be an idiot. And also, remember to reply to all the 
backers. Even the idiots.

Nick Veitch  
was the original editor 
of Linux Format, a 
role he played until he 
got bored and went 
to work at Canonical 
instead. Splitter! 

The Debian Project Leader shares his hacking environment.

Sennheiser HD25-1 
headphones – in a 
previous life I was a
sound engineer…

Lenovo X220 – 
works flawlessly!

I’ve always preferred 
trackballs to mice – they 
seem to work better.

Mechanical keyboard 
from Filco, with cherry 
brown keys, but also 
rubber dampers.

What version of Linux are you 
currently using?
I’m currently running the latest 
release of Debian 8 “Jessie”, 

unsurprisingly.

And what desktop do you 
currently use?
I’m using Gnome 3.14 – I’ve tried a 
few different ones, and it seems to 

be the most complete at the moment.

What was the first Linux setup 
you ever used?
The first install I did was Mandriva, 
about 13 years ago. However, I 

moved on to Debian after about a year, 

and have been running that ever since.

What Free Software/open source 
can’t you live without?
As most of my job involves 
communications, and a lot of it, I’ll 

have to go with a combination of Irssi for 
IRC and Mutt for email. Text-based 
interfaces are the only way I’m able to stay 
on top of things!

What do other people love but 
you can’t get on with?
Not wanting to cause a holy war, but 
I guess Emacs. I’m a Vim user, and I 

just never seem to have enough fingers to 
make Emacs work for me.  

LV016 114 Geek Desktop.indd   114 08/05/2015   11:15



CC-BY SA

LV016 115 Inside Back Cover.indd   115 07/05/2015   09:49



LV016 116 Back Cover.indd   116 07/05/2015   09:51


